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Preface 

Please read the User Manual carefully before using this product. The operating procedures 

specified in this User Manual should be followed strictly. This manual describes in detail the 

operation steps which must be noted, the procedures which may result in abnormality, and possible 

damage to the product or users. Refer to following chapters for details. Failed to follow the User 

Manual may cause measuring abnormality, device damage or personal injury. The manufacturer is 

NOT responsible for the safety, reliability and performance issues of such results due to user’s 

negligence of this manual for using, maintenance or storage. The free services and repairs do not 

cover such faults either. 

Caution: Please read the User Manual carefully before using this product. 

For product upgrade, the device you received may not exactly in keeping with the description in 

this user manual, and we sincerely apologize for that. 

Precautions 

Please consider the security and validity before putting the product into use: 

 Safety classification: internally powered, type BF 

 Measurement results should be explained by professional doctor combined with clinical 

symptoms. 



 

III 

 The reliability of this product depends on whether the operator's operation is in accordance with 

the operating and maintenance instructions of this manual. 

 The intended operator may be the patient. 

 No maintenance or repair during device using. 

Warning: Replacement of accessories that are not supplied by our company may result in 

errors. Any maintenance personnel who has not been trained by our company or other 

authorized service organization should not attempt to maintain the product. 

Responsibility of the user 

 The user should read this user manual carefully before operating, and operate it in accordance 

with the manual. 

 Although the device has been designed with a view to safety requirement enough, the user 

should not neglect the state of the equipment and patient observation. 

 The user is responsible to supply the use situations of device to our company. 

Responsibility of Our Company 

 Our company supplies the qualified product to the user in accordance with enterprise standard. 

 Our company performs device repair in warranty period (a year) and maintenance after warranty 

period. 
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 Our company responds promptly to the user's request. 

 Upon request, our company may provide, with compensation, necessary circuit diagrams, 

calibration instructions and other information to help qualified technician to maintain and repair 

some parts, which our company may define as user serviceable. 

 Our company is responsible for safety, reliability and performance of the device only in the 

conditions that: 

All installation, expansion, debugging, change, and repair of this device are conducted by our 

qualified personnel; and, 

Applied electrical appliance is in compliance with relevant requirements, and the device is operated 

under strict observance of this manual. 

This user manual is written by our company. All rights reserved. 
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Chapter 1 General 

 For safety use, to avoid harm or loss to user due to improper use, be sure to observe this Safety 

Precautions. 

 For an overall introduction to the patient monitor, please refer to Device Introduction. 

 For the location of each interface, please refer to External Interfaces. 

1.1 Safety precautions 

 Caution  

Improper use may result in personal injury or property damage. 

Property damage is related to the damage of housing, family property, livestock and pets. 

 Contraindication  

No. 

 Warning  

For the patient with severe blood circulation disorders or blood disease, please use it under the 

guidance of a doctor. Extrusion of the arm during measuring may result in acute ischemia or 

erroneous measurement. 
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 Warning  

Noninvasive blood pressure measurements should not be made on sickle cell disease and any patient 

with skin damage or who is expected to be harmed. 

 Warning  

For patients with severe coagulation disorders, the implementation of automatic blood pressure 

measurement shall be determined according to their clinical evaluation, because the rubbing 

between limbs and cuff may result in a danger of hematoma. 

 Warning  

Possible hazard if used in the presence of flammable anesthetics or other flammable substance in 

combination with air, oxygen-enriched environments, or nitrous oxide. 

For infants or patient without the capacity of consciousness and behavior, please use the device under 

the guidance of a doctor. Otherwise it may cause accident or dissension. 

Self-diagnosis and treatment by measure results may be dangerous. Please follow the instructions of 

your physician, and hand measure results to the doctor who knows your health state for diagnosis. 

The device is not intended for use for other purpose except blood pressure measurements, otherwise 

it may result in accident or malfunction. 

Please do use the specified cuff, or the measurement result may be inaccurate. 
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Do not leave the cuff under over-inflated state for long time, Otherwise it may cause risk. 

If liquid splashes on the device or accessory especially when liquid may enter the pipe or device, stop 

using it and contact the service department. Otherwise it may cause risk. 

The disposal of the packaging material should follow the applicable waste control regulations and 

keep it out of children's reach. Otherwise it may cause harm to the environment or children. 

Please use specified accessories and verify if the device and accessories work safely and normally 

before use. If not, the measurement result may be inaccurate or cause accident. 

If the device gets damp accidentally, it should be placed in a dry and ventilated place for a period of 

time to dissipate moisture. Otherwise the device may be damaged due to moisture. 

The device should be stored or transported under the specified environment condition to avoid 

measurement error. 

It is recommended to regularly check if there is any damage on the device or accessories, if there is, 

stop using it and contact the biomedical engineer of hospital or our representative institution. Do not 

disassemble, repair or modify the device without permission, otherwise the measurement will be 

inaccurate. 

Measurement error may occur if the device is used on a moving platform. 

Possible falling risk if the device is placed on a tilted surface. 
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Dispose of packaging materials, waste batteries and end-of-life products in accordance with local 

laws and regulations. User should perform proper treatment to the waste products and materials 

according to the regulations. 

Replacement of accessories that are not supplied by our company may result in errors. 

Any maintenance personnel who are not trained by our company or other authorized service 

organization should not attempt to maintain the product. 

The device can only be used for one patient at a time. 

If the small parts on the device are inhaled or swallowed, please consult a doctor immediately. 

The device and accessories are processed with allergenic materials. If you are allergic to it , stop 

using this product. 

This device is suitable for use with electrosurgical devices, but it should be noted that, when used in 

conjunction with electrosurgical equipment, patient safety must be the top priority. 

 Caution  

This device has a certain resistance capability to electromagnetic interference, but the use of mobile 

phones, MRI (Magnetic Resonance Imaging) or other portable and mobile RF equipment may affect 

the measurement, so when using the device, these equipment should be turned off or away from the 

device. 

The electromagnetic radiation of the device is very low, basically it will not produce energy harm to 



 

 5 

human body, or interfere to the surrounding electronic equipment. However, the device will still 

produce slight electromagnetic radiation, it should keep away from high-precision required 

equipment. 

 Warning  

In addition to the transducers and cables sold by our company as spare parts for the internal 

components of this device, the use of unspecified accessories, transducers and cables will result in 

increased emissions or reduced immunity to this device. 

 Warning  

The device should not be used close to or stacked with other equipment, and if it is necessary to do 

so, please guarantee that the device is functioning properly in its intended configuration. 

 Warning  

Do not modify this device without authorization of the manufacturer. 

 Warning  

Active medical device is subject to specific EMC precautions, and therefore it must be installed and 

used in accordance with these guidelines. 
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 Caution  

Basic performance of EMC test: The waveform noise and measurement error in the testing can be 

automatically eliminated 10 s after harassment end. Before and after the test, the average error of 

NIBP measurement ≤ ± 0.67 kPa (5 mmHg), PR measurement error: ± 2 times/min. 

 Warning  

If the device is operating below the blood pressure measurement range that described in the 

"Specification" section, it may result in inaccurate results. 

 Warning  

This device may be interfered by other equipment even if other equipment meets the emission 

requirements of the corresponding national standards. 

 Caution  

If the electrolyte in the battery accidentally entered the eyes, please immediately rinse with plenty of 

water and go the nearest hospital, because there will be the risk of blindness and other injuries. 

 Caution  

If the electrolyte in the battery accidentally stuck to the skin or clothing, please immediately rinse 

with plenty of water, or it may cause skin injury. 
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 Caution  

The software was developed in accordance with IEC60601-1. The possibility of hazards arising 

from errors in the software program has been minimized. 

All analog and digital equipment connected to this device must be certified to IEC standards(such as 

IEC60950: Information technology equipment-Safety and IEC60601-1: Medical electrical 

equipment-Safety), and all equipment should be connected to in accordance with the requirement of 

the valid version of the IEC60601-1-1 system standard. The person connecting the additional 

equipment to the signal input and output port is responsible for whether the system complies with 

the IEC60601-1 standard. 

The software is developed in accordance with IEC60601-1-4. The possibility of risks arising from 

errors in the software program has been minimized. 

Refer to the following chapters for the minimum value of patient physiological signals. Operating 

the device below the minimum value specified in the following chapters may result in inaccurate 

results. 

1.2 Device introduction 

Working environment: 

Temperature: 

Working: +5 ºC～+40 ºC 
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Transport and storage: -20 ºC～+45 ºC 

Humidity: 

Working: 15 %～85 %(no condensation) 

Transport and storage: ≤ 95% (no condensation) 

Atmospheric pressure: 

Working: 700hpa ~ 1060hpa 

Transport and storage: 700hpa ~ 1060hpa 

 

Power supply: DC 3.7V 

Service life: 5 years or 10,000 times of measurements (within 5 years) 

Safety classification: internally powered, type BF defibrillation-proof applied part 

The parts of the device (cuffs, extension tubes, enclosures, etc.) in contact with the patient are made 

of insulating material and the device is protected against electric shock. When high frequency or 

defibrillation devices are applied to the patient, no special precautions are required. 

The device is suitable for adults, for dynamic NIBP monitoring, it can store up to 500 groups of data. 

The data can be uploaded to the computer analysis software through the interface on device back, 

realizing editing of data, trend graph and diagnostic information, and statistics, display, parameter 

settings, printing and other related processings (see the Software Function for details). 
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 Caution  

The monitor can not transmit measurement results in real time, the storage media within the 

monitor can only store one patient's blood pressure data. 

1.3 External interfaces 

To facilitate the operation, different interfaces are located in different parts of the monitor. 

The operating button is located on the top panel of the monitor. The display of LCD screen includes: 

current time, the specific pressure value in the cuff, measured diastolic blood pressure, systolic 

blood pressure, pulse rate, mean arterial pressure and prompt information. The socket of NIBP cuff 

extension tube is located at the top of the device; the data playback interface is located at the bottom. 

Top of the device: the button, socket of cuff extension tube 

 

Figure 1.3.1 Top View 
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Bottom of the device: data playback interface 

 

Figure 1.3.2 Bottom View 

 Caution  

If the monitor is connected with an USB cable without measuring blood pressure, the monitor will 

not be able to process blood pressure measurement until the USB cable is disconnected. 

When the monitor is measuring blood pressure, if a USB cable is inserted, the monitor will 

automatically cancel the measurement. 

1.4 Accessories 

Adult cuff, user manual, extension tube, bag, software,USB data line,lithium batter,Adaptor

（optional） 

 Caution  

The device is applicable for adults only. 



 

 11 

 Warning  

Please use specific accessories provided by the manufacturer, and replace the accessories 

according to the requirements of the manufacturer, in order to avoid injury to the human 

body. 

 Caution  

 The cuff is a consumable. If measurement is taken 6 times per day (three times of every 

morning and evening), the service life of cuff is approximately 1 year (under our company's 

test conditions). To get correct measurement results, it is recommended to replace the cuff in 

time; 

 If air leakage occurs, please contact our company to buy a new one. The separately purchased 

cuff does not include extension tube. Pleas let us know if you need the extension tube at the 

same time. If you do not want to buy the extension tube, please do not throw it away, and 

install it on the new cuff when replacing. 

 Potable bag is convenient for user to carry the device. When it is slightly worn, it does not 

need to be replaced. User can contact our company to purchase depending on demand or 

when the bag is seriously damaged. 
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 Caution  

At the end of the service life, the product described in this manual, as well as its accessories, must be 

disposed in compliance with relative disposal regulations. If you have questions concerning disposal 

of the product, please contact us or representative institution. 

Software information: 

Name: ABPM60 

Specification: No 

Version:V1.0 

Naming rule: V<Important enhancive software upgrades> <Enhancive software upgrades> 

<Corrective software upgrades> <build> 

Algorithm: 

Name: oscillametric method 

Type: new arithmetic 

Intended use: to measure blood pressure-related parameters 

Clinical function: By sampling and processing the pulse signals of the patient, the algorithm 

calculates the value of blood pressure. 
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Chapter 2 Installation 

2.1 Open the package and check 

Open the package and take out the monitor and accessories carefully. Keep the package for possible 

future transportation or storage. 

 Check for any mechanical damage. 

 Check all the accessories. 

 If there is any problem, contact our sales department or agent immediately. 

2.2 Battery installation 

The device is power supplied by one lithium battery. Before use, the battery should be installed in 

the battery compartment located at the rear of the device. The operation steps are: 
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     ①                                ②                       ③ 

① Follow the direction of the arrow to remove the battery cover; 

②Install the battery into the battery cover according to the  polarities; 

③Close the battery cover. 

Icon “ ”: It means that the battery is low, and the device makes sound prompt intermittently, 

please charge it by connecting with a USB cable or replace the battery. If the measurement is taken 

under low battery conditions, the measured data may be inaccurate. 

 Caution  

If the battery is unable to meet the working requirements, the device will make the low battery 
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prompt, and will automatically turn off if the battery power decreases continuously. Please turn off 

the device or take out the battery if you are not going to use the device for a long time. 

 Caution  

If the battery reaches its service life, or battery smell, deform, discolor or distorted appears, please 

stop using the battery and dispose it in accordance with local regulations. Or it may cause 

environment pollution. 

 Caution  

This monitor belongs to internally powered device and can not be connected to public supply 

network during normal operation but connected to public supply network when charging. 

 Caution  

Please take the batteries out when not using the device. 

 Warning  

The battery should not be replaced by inadequately trained personnel, incorrect replacement 

operations (such as reversed installation, the wrong type of battery installed) may result in dangers 

of overheating, fire, or explosion. 
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2.3 Startup 

After the battery is installed, the device will automatically turn on, and start the measurement 

according to the scheme set last time. 

 Warning  

Do not use this device for patient monitoring if it is found damaged or an error message appears, 

please contact your hospital's biomedical engineer or our service engineer for maintenance 

immediately. 

 Caution  

Check all functions that may be used, to ensure the device functions properly. 

2.4 Cuff connection 

 Caution  

Please refer to Figure 2.4.1~2.4.2 for the correct method of cuff connection. 

 

Figure 2.4.1 Connection between Extension Tube and Cuff 
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Figure 2.4.2 Wearing of Whole Device 
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Chapter 3 Display and Buttons 

3.1 Display interfaces 

 Caution  

For the first time of turning on the device, all displayable sections should be displayed on the 

screen, if any section is missing, there may be something wrong with the display screen, please 

contact us for maintenance. 

Correctly install one lithium battery in the battery compartment of the device, and fasten the 

cover of the battery compartment, the device will display the system time on the screen. (This 

system time may not be the current correct time, it can be corrected when transmitting the 

measurement scheme into the device, so the device does not have the time adjustment function.) 

The screen also displays the followings: the pressure value during the measuring process, the 

measurement result, the countdown before taking the next measurement, the battery level, and error 

messages. 

 



 

19 

 

Figure 3.1.1 Main interface    

                            

Figure 3.1.2 Measurement results 

  

 Figure 3.1.3 Error message 
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Figure 3.1.4 Version information           

 Caution  

When the memory is full, the number of records displayed in the main interface is 500 in red 

font, and the earliest record will be overwritten if the memory overflows. 

When using the USB cable to connect the device with the computer, the device displays the 

version information, as shown in Figure 3.1.4. 

3.2 Button functions 

When transmitting the measurement scheme into the device, if the “Manual Measure” switch is 

set to on, and press the button in the main interface, the device will start a measurement. Pressing 

the button again during measuring can stop the measurement. When you press and hold the button, 

the device will give a prompt, and if you long press the button again within 3s, it will turn off, 

otherwise, the device returns to the main interface. 

When an error occurs during measuring, the screen will display an error message and the 
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buzzer will beep, as shown in Figure 3.1.3 (see section 4.3 for the explanation of error message 

codes). 

When the measurement result is outside the set normal range, the measurement result will be 

displayed in red font and the buzzer will beep. 

If the prompt sound switch is set to on when transmitting the measurement scheme into the 

device, the device will generate the prompt sound when an error message is displayed. Pressing the 

button can turn off the prompt sound. 
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Chapter 4 NIBP Monitoring 

4.1 Overview 

 The NIBP measurement adopts Oscillometric method. 

 Measurement mode: manual/auto mode. The measured value of SYS, MAP, DIA and PR can be 

displayed in every mode. 

 In "Manual" mode, the device only takes the measurement once. 

 In "Auto" mode, the device takes the measurement circularly. Time interval can be set as 

5/10/15/20/30/40/60/90/120/180/240 min. 

 Caution  

 Do not speak or move when measuring, and avoid any muscle movements. 

 Do not use any mobile devices, such as a mobile phone, near the device during measurement. 

 The position of the cuff will cause changes in the measurement results. 

 Do not touch the monitor, cuff and extension tube during the measurement. 

 For information on contraindications for NIBP measurements, refer to section 1.1 Safety 

Precautions. 

 The device has dual over-pressure protection function in both hardware and software, if the 

airbag is over inflated, the device will reset and deflate immediately. If the over inflation lasts long, 
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immediately disconnect the cuff from the device and cut off the power. 

 Use this device in an environment where temperature and humidity are appropriate, as this may 

cause measurement error. 

 If the measurement interval is short, please pay close attention to the battery power, and replace 

the battery in time when the device prompts for low battery, otherwise the 24-hour ambulatory blood 

pressure monitoring may not be achieved. 

4.2 NIBP monitoring 

 Warning  

Do not apply the cuff to a limb that has an intravenous infusion or catheter. This could cause tissue 

injury around the catheter when infusion is slowed or blocked during cuff inflation. 

The minimum value of the patient's physiological signal is the lowest limit that the device could 

measure. The measured result may inaccurate if the device running below the minimum amplitude 

or minimum value of patient's physiological signal. 

The effect of  blood flow interference and  resulting  harmful injury to the patient caused by 

contious cuff prssure due to connection tubing kinking; 

Due to blood flow interference, too frequent measurements can caue injury to the patient. 

Need to check by observation of the limb concerned that operation of the Automated 

sphygmomanometer does not result in prolonged impairment of the circulation of the blood of the 
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patient; 

Do not use the cuff on the injured area, otherwise it will cause more serious damage to the injured 

area. 

Do not use the cuff on the site where intravascular treatment is being performed or with catheter 

connection, otherwise it may cause temporary blockage of blood flow and then cause injury to the 

patient. 

Do not use the cuff on the side of the mastectomy or lymph node clearance; 

The pressure by cuff may cause temporary weakness of some functions of the body. So do not use 

monitoring medical electrical equipment on corresponding arm. 

Do not move during measuring, or the blood flow of patient may slow down. 

The device needs 2 hours to recover from the lowest storage temperature to reach its performance of 

intended use. 

The device needs 4 hours to recover from the highest storage temperature to reach its performance 

of intended use. 

1. Insert the inflation tube to the cuff interface, connect the device to the power supply. 

2.Follow the method described below to apply the cuff to the patient’s upper arm. 

Δ Make sure that the cuff is fully deflated. 

Δ Choose proper cuff size for the patient, ensuring that the symbol φ is just above the appropriate 
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artery. The cuff should not wrapped too tight around the limb, otherwise it may cause extremities 

ischemia. 

 

Figure 4.2 Cuff Wearing 

 Caution  

The inflatable part of the cuff should be long enough to encircle 50～80% of the limb. Use of 

improper size cuffs may result in erroneous readings. If the cuff does not fit, use a relative 

larger cuff to reduce the error. 

Cuff applicable range: 25～35cm 

 Make sure that the cuff edge falls within the range of mark <->. If it does not, use a larger or 

smaller cuff that fits better. 
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 Connect the cuff to the inflation tube. The limb chosen for taking the measurement should be 

placed at the same level as the patient's heart. 

 If this is not possible, you should apply the following corrections to the measured values: 

If the cuff is placed higher than the heart level, plus 0.75 mmHg (0.10 kPa) for each centimeter of 

difference. 

If it is placed lower than the heart level, minus 0.75 mmHg (0.10 kPa) for each centimeter of 

difference. 

Measurement Way: 

Measurement in quiet and relaxing state. 

1.Adopt a comfortable sitting position, use back and arms to support the 

body. 

2.Place your elbow on a table, the palm faces up and the body is relaxed. 

3.The cuff is level with your heart. 

4.Feet flat on the floor, and do not cross your legs. 

 Advice   

Try to measure your blood pressure at the same time each day with the same arm and the 

same pose for consistency. 

The high and low location of cuff will cause changes in measure results. 
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Do not touch the sphygmomanometer, cuff and windpipe during measure.   

Measurements should be taken in a quiet place and the body relax. 

Remain still 4~5 minutes before measurement. 

Do not talk and movement during the measurement. Relax the body, do not let the muscle activity. 

Do not use precision instrument near the Sphygmomanometer. 

 Warning  

If the time interval of ambulatory blood pressure monitoring is set too long, the patient's arm or limb 

wearing the cuff may appear purpura, ischemia and nerve damage. When monitoring a patient, it is 

necessary to often check patient's limb distal color, warmth and sensitivity. Once any abnormality is 

observed, change the location of the cuff or stop the measurement immediately. 

 Caution  

If there is any doubt about the accuracy of the reading, examine the vital signs of the patient by 

possible means before checking the monitor's function. 

 Warning  

If liquid is inadvertently splashed on the device or its accessories, especially when the liquid 

may enter the tube or device, please stop using and contact with qualified maintenance 

personnel. 
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Measurement Limitations 

The oscillatometric method has certain limitations depending on the patient's condition. This 

measurement method relies on the searching of regular pulse waves generated by arterial pressure. If 

the patient's condition makes it difficult to using such method, the measured value will become 

unreliable and the time of measurement will increase. User should be aware of that the following 

conditions may interfere with the measurement method, making the measurement unreliable or the 

measurement time prolonged. In this case, the measurement method is impossible due to the 

patient's condition. 

 Patient Movement 

Measurements will be unreliable or may not be possible if the patient is moving, shivering or having 

convulsions. These motions may interfere with the detection of the arterial pressure pulses. In 

addition, the measurement time will be prolonged. 

 Cardiac Arrhythmia 

Measurements will be unreliable or may not be possible if the patient's cardiac arrhythmia has 

caused an irregular heartbeat. The measuring time thus will be prolonged. 

 Heart-lung Machine 

Measurements will not be possible if the patient is connected to an artificial heart-lung machine. 

 



 

29 

 Pressure Changes 

Measurements will be unreliable or may not be possible if the patient's blood pressure is changing 

rapidly over the period of time during which the arterial pressure pulses are being analyzed to obtain 

a measured value. 

 Severe Shock 

If the patient is in severe shock or hypothermia, measurements will be unreliable since reduced 

blood flow to the peripheries will cause a decrease in arterial pulsation. 

 Heart Rate Limitation 

Measurements can not be made if the heart rate is below 40bpm and above 240bpm. 

 Obese patients 

The thick fat layer will lower the accuracy of the measurement, because the arterial oscillation will 

be hard to reach the cuff due to the damping of fat. 

The BP value measured in the following situations may be different: 

 After eating (within 1h), or having drinks containing alcohol, caffeine or black tea; 

 After smoking, taking exercises or bathing; 

 Talks or body moves during measurement; 

 Patient is nervous, excited or in unstable emotion; 

 Adopts wrong posture, such as bend down (lean forward) or cross legs; 
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 A sharp increase/decrease in room temperature, or measurement temperature changes 

constantly; 

 Measured on a moving vehicle; 

 Long term continuous measurement. 

4.3 NIBP error messages and causes 

Display message Cause Solution 

Low battery Device battery is low. 
Replace the battery. If the problem 

still exists, please contact us. 

Loose cuff Cuff is not connected correctly. 
Reconnect the cuff. If the problem 

still exists, please contact us. 

Atmospheric 

pressure error 
Valve can not be open. 

Restart the device. If the problem still 

exists, please contact us. 

Signal is too 

weak 

Object measuring the pulse is too 

weak or the cuff is loose. 

Check the cuff connection, tighten 

the cuff if it is loose. 

It is over the 

range 

Object measuring blood pressure is 

over the measurement range. 

Take another measurement. If the 

problem still exists, please contact us. 

Excessive 

movement 

Movement may result in too much 

interference in the signal during 

Be sure to keep still during 

measuring process. 
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measuring process. 

Overpressure 
Cuff pressure is over the scope, 

ADU 300 mmHg. 

Check the cuff to make sure it is not 

blocked or squeezed. 

Saturated signal  
Movement or other factors may 

lead to too big signal amplitude. 

Check the connection of air tube to 

make sure it is not squeezed. Patient 

should keep quiet and then take a 

new measurement. 

Air leakage 
Possible air leakage in the valve or 

airway 
Check the air tube and the cuff. 

System failure 
Possible failure caused by pump, 

air valve or pressure sensor. 
Please contact us. 

It spends too 

much time 

The time for a single measurement 

exceeds the maximum 

measurement time (adult: 180s). 

Check the connection of air tube and 

tighten the cuff. 
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Chapter 5 Cleaning and Maintenance 

Be sure to observe the precautions and correct use in the manual. Otherwise, our company will not 

assume responsibility for product quality. 

 Warning  

 Remove the batteries before cleaning the device or peripheral equipment. The accessories 

must be separated from the main body and cleaned independently. 

 Do not squeeze the rubber hose on the cuff. 

Cleaning 

 In order to prevent damage to the device, do not allow water or cleaning fluid to enter into the 

device socket. 

 If the surface of device body, accessories and peripheral equipment get dirty, please use a dry 

soft cloth to wipe, do not wipe the interior of device. 

 If the surface of device body, accessories and peripheral equipment are particularly dirty, use 

a soft cloth moistened in water or neutral detergent to wipe. 

Maintenance 

 Please clean the device and its accessories frequently. 

The device should be inspected and calibrated regularly or according to the hospital's 
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inspection requirements (recommended period is 1 year). The inspection can be carried out by 

the state-designated inspection agency, or by professionals. The product has a static pressure 

detection mode for inspection. Please contact our after-sales service if you need to enter the 

mode. 

Cleaning of Reusable blood pressure cuff 

The cuff can be sterilized under high pressure in the conventional hot air oven and disinfected by gas 

or radiation disinfection method, or sterilized by immersing in the decontaminating solution. But 

remember to take away rubber bag when adopting such method. The cuff can be machine-washed 

and hand-washed, but can not be dry-cleaned. Hand washing may exceed its service life. Take out 

the rubber bag before washing the cuff and re-install it in the cuff after the cuff is washed and dried 

completely. 

            

Figure 5-1 Replacement of Rubber Bag 
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When re-installing rubber bag in the cuff, first put the rubber bag at the head end of cuff, and in this 

way, rubber hose and large opening at the long end of cuff will be in a line, next vertically roll up 

rubber bag and insert it in the large opening of cuff, then hold the rubber hose and cuff and shake the 

whole cuff till rubber bag is installed properly. Lead rubber hose in the cuff and thread it through 

hole lining. 

Storage method: 

 Suggestion  

Do not expose the device in direct sunlight for long time, otherwise the display screen may be 

damaged. 

The basic performance and safety of the device are not affected by dust or cotton wool in home 

environment, while the device shall not be placed where with high temperature, humidity or plenty 

of dust. 

Aged cuff may result in inaccurate measurement, please replace the cuff periodically according to 

the user manual. 

To avoid device damage, keep the device out the reach of children and pets. 

Avoid the device close to extreme high temperature such as fireplace, otherwise the device 

performance may be affected. 

Do not store the device with chemical medicine or corrosive gas. 
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Do not place the device where there is water. 

Do not place the device where with slope, vibration or impact. 
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Chapter 6 Hardware requirements 

CPU: 2.5GHz or higher 

OS: Windows XP or higher 

Memory: 1G or above 

Hard drive: 250G or above 

Display: 1024*768 or higher 

USB: at least 2 

Printer resolution: optimal 600dpi 
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Chapter 7 Software Functions 

7.1 Registration 

Double click the software icon, a dialogue box for entering user account pops up: 

 

 

Figure 7.1 Registration 

Please input your name, then click "Okay" to enter the main interface. Click "Delete", you can delete 

one registered user information, click "Delete all", you can delete all the registered user information. 

7.2 Main interface 

After finishing the registration, enter the main interface as shown below: 
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Figure 7.2 Main Operating Interface 

1. Menu: The main operating menu of this software 

2. Toolbar: Shortcut keys for functions of frequent use 

3. The middle area is used to display graphs. After choosing the case to be edited, the data analysis 

graph, including trend graph, histogram, pie chart and fit line will be displayed here. 
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7.3 Collection scheme setup 

Click the shortcut key or in the menu, a dialogue box "Upload Parameters" will 

appear: 

 

Figure 7.3.1 Setting of Collection Parameters 

As shown above, doctors could set the parameter according to patient’s condition and the need of 
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diagnosis. The monitor is able to finish the collecting task as your settings. Specific parameters are 

explained as follows: 

Patient Name: name of the patient 

Patient ID: It is an unique number used to identify the patient. The purpose is to prevent the 

occurrence of the same name patients. 

Manual measure: to support manual collecting, which means the measurement can be achieved by 

pressing the button on the device. 

Beep main switch: to turn on/off the master switch of prompt sound 

Awake Beep Switch: to turn on/off the prompt sound when the patient is in non-sleep state, the 

prompt range is determined by the four parameters below 

Asleep Beep Switch: to turn on/off the prompt sound when the patient is in sleep state, the prompt 

range is determined by the four parameters below. 

Current Time: current system time. 

Settings of parameters in time period: 

Day: non-sleep condition of the patient; 

Night: sleep condition;  

Special Start and Special End are optional items. You can set the data collection for special time 

periods.  
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Interval refers to the time interval of collection. To minimize the impact of sleep patients, generally 

collection interval during sleep condition is set to be longer. 

Take the above picture as an example: the range of awake time in the day is 7:00-22:00, the range of 

asleep time in the night is 22:00-7:00 (next day), the interval of the awake time is 30 minutes, and 

the interval of the asleep time is 60 minutes. 

The range of daytime duration, nighttime duration and special testing duration are displayed in 

graphic form on the screen, which facilitates the parameter setting. 

After setting the parameter, click "Okay" to upload the scheme. If the parameter is set correctly, and 

the monitor and computer are connected well, the data will start uploading. Uploading progress is 

shown as below: 

 

Figure 7.3.2 Uploading Progress Bar 

7.4 Download 

Before downloading, please make sure that: 

The device has been connected to PC correctly; 

The device is in power-on state; 
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The device is not connected to the patient when connecting with the PC. 

Click the shortcut key , or select "Download"→"Do Download" in the menu, after 

identifying the device, an interface for editing patient information appears on the software, in which 

you can edit the basic information of patients. After downloading a case, the patient information will 

be saved in the case file. The patient information editing interface is shown as below: 

 

Figure 7.4.1 Patient information 
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Click "Okay" to start downloading the data, the process bar is shown as below: 

 

Figure 7.4.2 Downing Progress Bar 

7.5 Path of case file 

User can choose the storage path of case files, select "System" in the menu, then 

select "Set File Path", the interface is shown as below: 

 

Figure 7.5 Case file path 
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7.6 Case select 

Before editing, choose a case file first. Click the shortcut key  or select "File" → "Open data" 

in the menu to enter case selection interface as shown below: 

 

Figure 7.6 Case Selection 

In the interface, you are able to select the file folder for data storage, if there are files in the folder, 



 

45 

all the file information will be listed, including: patient name, patient ID, start time and file name. 

Choose the file you want to edit, then click "Okay". 

7.7 Delete 

If some cases are not necessary any more, you can delete them. Select "File" → "Delete data" in the 

menu, the deleting interface will appear, which is similar to case selection interface, shown as 

below:  

 

Figure 7.7 Select a Case for Deleting 

You are able to delete one single file or multiple files at the same time; to delete multiple files, you 
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need to press "Ctrl" on the keyboard and select the files you want to delete, after that, click "Okey", 

an alert dialogue box will pop up, then click "Okay" to delete. If you want to cancel, please click 

"Cancel". 

7.8 Backup 

Sometimes, you may want to save one original copy before you edit a file, then you need to backup 

the case file. The software provides such function. Select "File" → "Copy data" in the menu to open 

the data backup interface, as shown below: 

 

Figure 7.8.1 Select a Case to Backup 
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After selecting the file, click "Okay", a dialog box of file path setting appears, as shown below, in 

which you can set the path of backup file, after that, click "Okay" to save. 

 

Figure 7.8.2 Backup Path Setting 

7.9 Blood Pressure Data 

You can edit each data record. Click the shortcut key or choose "Edit" → "BP data" in the 
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menu, the data editing interface as shown below will be displayed: 

 

Figure 7.9 Data Editing Interface 

 

In this interface, you can view the details for each data. In which, 

*=5/192(2.6%): 192 stands for data sum, 5 stands for the number of deleted data, 2.6% stands for 

the present of deleted data. 

Number: the serial number of data collecting. 
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Time: collecting time. 

Date: collecting date. 

Sys (mmHg): the high blood pressure value, its unit is mmHg; 

Dia (mmHg): the low blood pressure value, it unit is mmHg; 

PR (bpm): value of pulse rate, unit is bpm. 

MAP (mmHg): the average pressure value of high blood pressure and low blood pressure, unit is 

mmHg. 

PP (mmHg): pressure difference between high and low blood pressure, unit is mmHg. 

Position: displays the posture status if this function is available 

TC: error code 

Comment: notes for the data. 

These data can be edited. ‘*’ means that the data is deleted (it will not displayed in trend graph or in 

the record statistic). You can delete/add the ‘*’ by clicking the left mouse button in its area. Also, in 

the comment column, you can add notes for the data, and these information will be shown in the 

trend graph. 

By clicking buttons, you can display all data or hourly average value, or display by hour. 

7.10 Trend Graph 

After selecting a case, its trend graph will be shown on the computer automatically. In other 
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interfaces, clicking the shortcut key  could enter its interface. There are two types of trend 

graphs: trend for color filler style and trend for dotted line style. The trend shows as follows: 

 

Figure 7.10.1 Color Filler Style  
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Figure 7.10.2 Dotted Line Style 

Click the "Graph type" to switch between the two different trend graphs. When the cursor moves to 

the displaying area, data information that the mouse pointing will be shown on the top of the screen, 

including number, time, date, high/low BP value, PR, comment, etc. You can click the left mouse 

button to delete/add necessary data point. If the distance between the two data points is too short and 

the cursor cannot be moved to one of the points, move the cursor to the x-axis, press the left mouse 

button and drag the mouse to right, then the trend graph will be shown in a stretching form; and if 
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drag the mouse to left, the trend graph will be shown in a shrinking form. When the trend graph is 

stretched, you can control the movement of trend graph by scrollbar if it exceeds the displaying area, 

until you could observe the data you wanted. Similarly, you can also move the cursor to the y-axis, 

press the left mouse button and drag the mouse up/down to achieve stretching/shrinking display. 

 

Figure 7.10.3 Trend Graph Shrink (x-axis) 
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Figure 7.10.4 Trend Graph Stretch (x-axis) 
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Figure 7.10.5 Trend Graph Stretch (y-axis) 
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Figure 7.10.6 Trend Graph Shrink (y-axis) 
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7.11 Statistics information  

Click the shortcut key , or choose "Edit"→"View statistics" in the menu, a dialog box for data 

statistic information will pop up, as follows: 

 

Figure 7.11 BP Statistics Information 

The upper half of above figure shows the average value of the data. The lower half shows the 

percentage of data that exceeds the alarm limit. And the data 135/85, 120/70, 130/80 respectively 

represents the limit value of high/low pressure in the awake/ sleep/ whole day condition. The unit is 
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mmHg. 

7.12 Diagnostic information 

Click shortcut key , or select "Report"→"Diagnose" in the menu, as shown below: 

 

Figure 7.12.1 Diagnosis information 

Click "Auto con" button, the software will automatically analyze the current case and display 

the diagnosis conclusion. The conclusion has several items, which can be set by user. Click "Report 



 

58 

settings" to select "Analyze item", a dialogue box for choosing analysis items pops up, shown as 

below: 

 

Figure 7.12.2 Analysis items 

Also, you can choose to edit the diagnosis conclusion by your own, and edit, delete, add, and 

update the analysis items. 



 

59 

7.13 Sleep period setup 

Setup of sleep period includes: day time and night time. This is necessary because the patient 

may not sleep or wake up at the exact time set in the collection scheme when patient data is being 

collected. After setup, the software will recalculate the data, and update trend graph and recalculate 

the statistic information automatically. Select "System"→"Sleep Times" in the menu, a dialogue box 

shown as below will appear: 

 

Figure 7.13 Sleep period Setting 

7.14 Alarm limit setup 

The alarm limit of blood pressure can be set, after that, the trend graph will update 
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automatically, and the statistic data will be recalculated. Select "System"→"Threshold" in the menu, 

a dialogue box of BP alarm limit will pop up, as shown below: 

 

Figure 7.14 BP Alarm Limit Setting 
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In the day time, the default alarm limit of high/low blood pressure is 135mmHg/85mmHg; in 

the night time, the default alarm limit of high/low blood pressure is 120mmHg/70mmHg; in a whole 

day, the default alarm limit of high/low blood pressure is 130mmHg/ 80mmHg. 

Besides, the setting includes the followings: 

The normal range of "Day BP load value", default setting is less than 20%; 

The normal range of "Night BP load value", default setting is less than 25%; 

The normal range of "Circadian rhythm of BP ranges", default setting is 10%~20% 

The AASI is less than 0.55 in normal condition. 

The MBPS larger than 35mmHg indicates blood pressure elevation. 

7.15 Histogram 

Click the shortcut key , a histogram analyzing blood pressure and pulse rate will show 

up, as following: 
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Figure 7.15 Histogram 

The three values (SYS, DIA, PR) can be displayed for each time period by selecting "All", "Day" 

and "Night" on the right side. 

7.16 Pie Chart 

Click the shortcut key , a pie chart analyzing blood pressure and pulse rate will show up, as 
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following: 

 

Figure 7.16 Pie Chart 

Pie chart interface is divided into four parts. The first part displays the maximum/ minimum/ 

average value for the measured data; the second part is the pie charts; the third part provides 

corresponding settings for the pie charts on the left; the fourth part has three options of "All", "Day", 

"Night", the analysis of values for each time period can be shown individually. 
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7.17 Fitting line 

Click the shortcut key , the fitting line of blood pressure data will appear, as shown below: 

 

Figure 7.17 Fitting Line 

Red represents systolic blood pressure; blue represents diastolic blood pressure. The empty circle is 

the blood pressure value measured during the day and the filled circle is the blood pressure value 
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measured at night. 

Histogram, pie charts and fitting line help to observe the data. 

7.18 Report print 

The software supports printing in A4/B5 paper. If you want to print a report, first select "Start" 

→ "Printers and Faxes" → "default printer driver icon" in the system, click the right mouse button, 

choose "Properties" → "Printing Preferences" → "Paper", select A4/B5 as the paper size. Then open 

the software, click "Report" → "Select Printer", the printer selection interface will pop up. In this 

interface, you can select the printer you are connected to, as well as the default paper size for 

printing. If the default paper size of printer is A4 (B5), the software will print according to A4 (B5) 

size. 

When you finish the editing of blood pressure data, patient diagnostic information, etc., the 

software will generate a series of analysis reports. You can choose all reports or several of them for 

printing. 
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Select "System" → "Configurate Report" in the menu, the following dialog box will pop up: 

 

Figure 7.18.1 Report Configuration 

Click the shortcut key , or select "Report"->"Report" in the menu, it will directly go to 

the print preview interface. Operator could see the printing result of the page that just selected. Print 

preview interface as follows: 
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Figure 7.18.2 Print Preview 

Make sure that there are no mistakes in the report, click  on the top left corner of the 

interface, the attribute interface of printer will pop up, then click the "Okay" button, print job will be 

sent to the printer for printing. 

7.19 Help 

Click "Help"-> "Help Document" in the menu to pop up the help information, which gives a 

brief description of each function, and facilitates you to quickly know how to use the software. 
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Chapter 8 Transport and Storage 

 The packed device can be transported by general vehicle or according to the order contract. 

The device can not be transported with mixture of toxic, hazardous, corrosive materials. 

 The packed device shall be stored in a well-ventilated room without corrosive gases, and 

room environment shall be: 

 Temperature: -20 °C~+55 °C 

 Humidity: ≤95% (no condensation) 
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Chapter 9 Buttons and Symbols 

Signal Description Signal Description 

 

Attention! Please refer to the 

accompanying document (the user 

manual). 
 

Attention! Please refer to the 

accompanying document (the user 

manual). 

SYS Systolic pressure DIA Diastolic pressure 

MAP Mean blood pressure PR Pulse rate (bpm) 

SN Serial number   EMC Electromagnetic compatibility 

  Free of natural rubber latex P/N Material code of manufacturer 

ADU Adult INFO Information 

ABPM Ambulatory Blood Pressure Monitor  

Type BF defibrillator proofed applied 

parts 

 Class II equipment 
 

Open the prompt sound indication 

 Batch code 
 

Use by date 
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This way up 

 
Fragile, handle with care 

 
Keep dry 

 

Storage atmospheric pressure 

limitation 

 
Storage temperature limitation 

 
Storage humidity limitation 

 
Manufacturer 

 
Date of manufacture 

 Batteries Power   Pulse rate (bpm) 

 

Waste disposal mark, this symbol 

indicates that the waste of electrical 

and electronic equipment can not be 

disposed as an unclassified municipal 

waste and must be recovered 

separately. 

 
 Recyclable 
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Chapter 10 Product Specification 

Name Ambulatory Blood Pressure Monitor 

Operating mode Continuous operating 

Display 0.96'' color LCD Display 

Measurement 

method 
Oscillometric method 

Working modes Automatic 

Measurement range 
Pressure：0 ～ 300 mmHg（0 ～ 40 kPa） 

Number of pulse: 40 beats/minute～240 beats/minute 

BP measurement 

range 

SYS 30 mmHg～270 mmHg(4.0~36.0 kPa)； 

DIA 10 mmHg～220 mmHg(1.3~29.3 kPa)； 

Overpressure 

protection 
297 ± 3 mmHg（39.6±0.4 kPa） 

Resolution 1 mmHg 

Cuff Pressure 

Accuracy 
Static pressure: ±3 mmHg(±0.4 kPa) 
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Error 

The blood pressure value measured by this device is equivalent to 

the value measured by auscultation method, its error meets the 

requirement of IEC 80601-2-30:2018 . 

Transport  

Transport by general vehicle or according to the order contract, 

avoid pounded, shake and splash by rain and snow in 

transportation. 

Storage 

The packed device shall be stored in a well-ventilated room 

without corrosive gases, temperature within -20 ºC～+55 ºC, 

relative humidity no more than 95%. 

Temperature 
Working: +5 ºC～+40 ºC 

Transport and storage: -20 ºC～+55 ºC 

Humidity 
Working: 15%~85%(no condensation) 

Transport and storage: ≤ 95% (no condensation) 

Atmospheric 

pressure 

Working: 700 hpa ~ 1060 hpa 

Transport and storage: 700 hpa ~ 1060 hpa 

Battery service life 
Under the condition of room temperature 23℃, arm circumference 

270mm and measuring normal blood pressure value, a fully 
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charged lithium battery can support measurements 100 times or 

more. 

Rated voltage DC 3.7 V 

Rated Power 10 VA 

Dimensions 113(L)*67(W)*26 mm(H)   

Unit Weight 180 gram(with batteries) 

Safety classification 
Internally powered equipment, type BF defibrillation-proof applied 

part 

Service life 5 years of measurement 

Date of manufacture See the label 
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Chapter 11 After-sales Service 

Guidance and manufacturer's declaration – electromagnetic immunity – 

for all EQUIPMENT and SYSTEMS  

Guidance and manufacturer's declaration – electromagnetic emission 

The device is intended for use in the electromagnetic environment specified below. The customer 

of the user of the device should assure that it is used in such and environment. 

Emission test Compliance Electromagnetic environment – guidance 

RF emissions 

CISPR 11 
Group 1 

The device uses RF energy only for its internal 

function. Therefore, its RF emissions are very 

low and are not likely to cause any interference 

in nearby electronic equipment. 

RF emission 

CISPR 11 
Class B 

The device is suitable for use in all 

establishments other than domestic and those 

directly connected to a low voltage power 

supply network which supplies buildings used 

for domestic purposes. 
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Guidance and manufacturer's declaration – electromagnetic immunity – 

for all EQUIPMENT and SYSTEMS 

Guidance and manufacturer's declaration – electromagnetic immunity 

The device is intended for use in the electromagnetic environment specified below. The 

customer or the user of device should assure that it is used in such an environment. 

Immunity test 
IEC60601 test 

level 

Compliance 

level 

Electromagnetic 

environment - guidance 

 

 

Electrostatic 

discharge (ESD) 

IEC61000-4-2 

 

 

 

6 kV contact 

8 kV air 

 

 

 

6 kV contact 

8 kV air 

Floors should be wood, 

concrete or ceramic tile. If 

floor are covered with 

synthetic material, the 

relative humidity should be 

at least 30%. 

Power frequency 

(50/60Hz) 

magnetic field 

IEC61000-4-8 

 

3A/m 

 

3A/m 

Mains power quality should 

be that of a typical 

commercial or hospital 

environment. 

NOTE: UT is the a.c. mains voltage prior to application of the test level. 
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Guidance and manufacturer's declaration – electromagnetic immunity – 

for EQUIPMENT and SYSTEMS that are not LIFE-SUPPORTING 

Guidance and manufacturer's declaration – electromagnetic immunity 

The device is intended for use in the electromagnetic environment specified below. The 

customer or the user of device should assure that it is used in such an environment. 

Immunit

y test 

IEC60601 

test level 

Compliance 

level 
Electromagnetic environment - guidance 

 

 

 

 

 

 

 

 

 

Radiated 

RF 

 

 

 

 

 

 

 

 

 

3 V/m 

80 MHz to 

 

 

 

 

 

 

 

 

 

 

3 V/m 

Portable and mobile RF communications 

equipment should be used no closer to any part 

of the device, including cables, than the 

recommended separation distance calculated 

from the equation applicable to the frequency of 

the transmitter. 

Recommended separation distance 

P
E

d 









1

5.3

   80 MHz to 800 MHz 
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IEC 

61000-4-

3 

 

 

2.5 GHz 

 
P

E
d 










1

7

     800 MHz to 2.5 GHz 

Where P is the maximum output power rating of 

the transmitter in watts (W) according to the 

transmitter manufacturer and d is the 

recommended separation distance in metres (m). 

Field strengths from fixed RF transmitters, as 

determined by an electromagnetic site survey, a 

should be less than the compliance level in each 

frequency range.b 

Interference may occur in the vicinity of 

equipment marked  

with the following symbol: 

 

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is 
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affected by absorption and reflection from structures, objects and people. 

a Field strengths from fixed transmitters, such as base stations for radio 

(cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio 

broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the 

electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey 

should be considered. If the measured field strength in the location in which the device is 

used exceeds the applicable RF compliance level above, the device should be observed to 

verify normal operation. If abnormal performance is observed, additional measures may be 

necessary, such as reorienting or relocating the device. 

Recommended separation distances between portable and mobile 

 RF communications equipment and the EQUIPMENT or SYSTEM –  

for EQUIPMENT or SYSTEM that are not LIFE-SUPPORTING 

Recommended separation distances between  

portable and mobile RF communications equipment and the device 

The device is intended for use in an electromagnetic environment in which radiated RF 

disturbances are controlled. The customer or the user of the device can help prevent 

electromagnetic interference by maintaining a minimum distance between portable and 

mobile RF communications equipment (transmitters) and the device as recommended below, 
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according to the maximum output power of the communications equipment. 

Rated maximum 

output power of 

transmitter (W) 

Separation distance according to frequency of transmitter (m) 

80 MHz to 800 MHz 

 

800 MHz to 2.5 GHz 

 

0.01 0.12 0.23 

0.1 0.37 0.74 

1 1.17 2.33 

10 3.69 7.38 

100 11.67 23.33 

For transmitters rated at a maximum output power not listed above, the recommended 

separation distance d in metres (m) can be estimated using the equation applicable to the 

frequency of the transmitter, where P is the maximum output power rating of the transmitter 

in watts (W) according to the transmitter manufacturer. 

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range 

applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is 

affected by absorption and reflection from structures, objects and people.  

P
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